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Version modification instruction  

 

Date  Modification content  

2017-08-14 In chapter 9 and 10, 485 and 232 communication example are added.  

2017-08-17 In chapter 11, SDO example is added.  

2017-12-12 Modify part of text problem  

2017-12-28 In chapter 11, description of RPDO is modified,  

2018-03-09 Description of terminal resistor (SW8) in FD123 and FD133 is added.  

2018-04-25 SMS absolute motor is added.  

2018-09-27 Chapter 3.5 Increase Wire Pressing Terminal Wiring Specifications  

2018-11 Added FD1X4 instructions for operation  

2019-04 Update FD1X4S instructions for operation  

2020-07  
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  Preface  Product Acceptance  

 Thank you for using Kinco Servo product ! 

The accessories of Kinco  every series & different types drivers are different. We advice you  

accept products before use.

Item for Acceptance     Remark  

Whether the model of a delivered FD series  

servo system is consistent with the specified 

model  

Check the nameplate of a servo motor and that 

of a servo  driver  

Whether the motor wiring is correct  Purchase motor accessory packages if no wiring 

are purchased  

Whether the accessories included in the packing 

list are complete  

Check the packing list  

Whether any breakage occurs  Check the external appearance completely for 

any losses  that are caused by transportation  

If there is any problem with any of the abov e, please contact our 

company or your supplier to solve it.  
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уΦо ¢!wD9¢ h.W9/¢εл·слт!ζ ................................................................................................................................. млн 

уΦп 5Lb {t995κth{L¢Lhbεл·нлнлζ .......................................................................................................................... млп 

уΦр t9wChwa!b/9 h.W9/¢{εл·слсрζ ...................................................................................................................... млр 

уΦс Iha9 /hb¢wh[εл·слфуζ ................................................................................................................................ млс 

уΦт ±9[h/L¢¸ [hhtεл·слCфζ .................................................................................................................................. млс 

уΦу th{L¢Lhb [hhtεл·слC.ζ ................................................................................................................................. млт 

уΦф Lbt¦¢ ϧ h¦¢t¦¢εл·нлмлζ .............................................................................................................................. млт 
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уΦмл t¦[{9 Lbt¦¢εл·нрлуζ ................................................................................................................................... ммл 

уΦмм {!±9εл·нCCлζ .............................................................................................................................................. ммм 

уΦмн 9wwhw /h59εл·нслмζ ................................................................................................................................... ммм 

уΦмо {¢ht ................................................................................................................................................................. ммн 

/I!t¢9w ф w{нон ................................................................................................................................................. ммп 

фΦм w{нон ²LwLbD 59CLbL¢Lhb ..................................................................................................................................... ммп 

фΦмΦм tƛƴ ŘŜŦƛƴƛǘƛƻƴ ............................................................................................................................................. ммр 

фΦмΦн aǳƭǘƛπǇƻƛƴǘ ŎƻƴƴŜŎǘƛƻƴ ............................................................................................................................. ммр 

фΦн ¢w!b{thw¢ twh¢h/h[ ........................................................................................................................................... ммс 

фΦнΦм tƻƛƴǘπǘƻπǇƻƛƴǘ ǇǊƻǘƻŎƻƭ ............................................................................................................................. ммс 

фΦнΦн aǳƭǘƛπǇƻƛƴǘ ǇǊƻǘƻŎƻƭ.................................................................................................................................. ммт 

фΦо 5!¢! twh¢h/h[ .................................................................................................................................................... ммт 

фΦоΦм 5ƻǿƴƭƻŀŘ όŦǊƻƳ Ƙƻǎǘ ǘƻ ǎƭŀǾŜύ ................................................................................................................. мму 

фΦоΦн ¦ǇƭƻŀŘ όŦǊƻƳ ǎƭŀǾŜ ǘƻ Ƙƻǎǘύ ...................................................................................................................... ммф 

фΦп w{нон ¢9[9Dw!a 9·!at[9 .................................................................................................................................... ммф 

/I!t¢9w мл w{пур /haa¦bL/!¢Lhb ................................................................................................................. мнн 

млΦм w{пур ²LwLbD ................................................................................................................................................... мнн 

млΦн w{пур /haa¦bL/!¢Lhb t!w!a9¢9w{ ................................................................................................................... мнн 

млΦо ah5.¦{ w¢¦.................................................................................................................................................. мно 

млΦп C¦b/¢Lhb /h59 hC ah5.¦{ ................................................................................................................................ мно 

млΦр ah5.¦{ a9{{!D9 9·!at[9 ................................................................................................................................. мнр 

/I!t¢9w мм /!bht9b ......................................................................................................................................... мнт 

ммΦм /!bht9b /haa¦bL/!¢Lhb twh¢h/h[ .................................................................................................................. мнт 

ммΦн I!w5²!w9 Lb¢wh5¦/¢Lhb ................................................................................................................................... мну 

ммΦо {hC¢²!w9 Lb¢wh5¦/¢Lhb .................................................................................................................................... мнф 

ммΦоΦм 95{ ƛƴǘǊƻŘǳŎǘƛƻƴ ..................................................................................................................................... мнф 

ммΦоΦн {5h ƛƴǘǊƻŘǳŎǘƛƻƴ .................................................................................................................................... мнф 

ммΦоΦо t5h ƛƴǘǊƻŘǳŎǘƛƻƴ .................................................................................................................................... мол 

ммΦп /!bht9b /haa¦bL/!¢Lhb 9·!at[9 .................................................................................................................... мор 

ммΦпΦм /ƻƴƴŜŎǘ ǘƻ YƛƴŎƻ{ŜǊǾƻҌ .......................................................................................................................... мор 

ммΦпΦн /ƻƴŦƛƎǳǊŜ /!bƻǇŜƴ ǇŀǊŀƳŜǘŜǊǎ ............................................................................................................. мот 

ммΦпΦо t5h ǘǊŀƴǎƳƛǎǎƛƻƴ ƳƻŘŜ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ................................................................................................... мпл 
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ммΦпΦп /!bƻǇŜƴ ǎŜƴŘ ƳŜǎǎŀƎŜ ŜȄŀƳǇƭŜ ........................................................................................................... мпр 

.-4 ƳŀƴŀƎŜƳŜƴǘ ƳŜǎǎŀƎŜ ............................................................................................................................ мпр 

!tt9b5L· м/hbCLD¦w9 ¢ILw5πt!w¢¸ ah¢hw{ .................................................................................................. мрм 

!tt9b5L· нChwa¦[! .......................................................................................................................................... мро 

!tt9b5L· о¦{9 hC .w!Y9 w9{L{¢hw ................................................................................................................... мрр 

!tt9b5L· пD9b9w![ [h!5 Lb9w¢L! /![/¦[!¢Lhb ............................................................................................. мрс 
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Chapter 1 System configuration and types 

1.1 product specification                  

1.1.1 FD1X3 Technical Specifications Table 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE: According to EN 61800-5-1:2007+A1:2017 

 

 

 

 

IG4560ΑΑ033Α IG4660ΑΑ033Α

Main supply voltage

Control circuit voltage

Udwhg fxuuhqwεupvζ10A 20A

Peak current (PEAK) 45A 50A

0.565 0.889

Input specification

Input function

Output specification

Output function 

RS232

Protection function

Modbus/RS485

CanOpen

Ethercat

Support maximum 1MHz baudrate. Communicate with controller via CANopen protocol

Vxssruw FrH+FlD735 surwrfro, dqg FVS2FVY2SS2SY2SW2KP prghιFrppxqlfdwlrq vshhg 433P

Bus

communicati

on function

The max. baudrate is 115.2KHz, use Modbus RTU protocol to communicate with controller.

FD1X3 servo driver
Model Parameter

Under-voltage alarming threshold 4;Y°5Y

Cooling method Natural air cooling

General

Functions

4 digital inputs, with COM1 terminal / kljk ohyho=4518¢63YGF/orz ohyho=3¢8YGF/ pd{ iuhtxhqf|=4NK]/ lqsxw lpshgdqfh=8NƑ

Define freely according to requirement, supporting following functions: Driver enable, driver fault reset, driver mode

control, proportional control, positive limit, negative limit, homing signal, reverse command, internal speed section control,

internal positive section control, quick stop, start homing, actie command, switch electronic gear ratio, switch gain.

6 gljlwdo rxwsxwvιwkh rxwsxw ri RXW4 RXW5 lv 433pDι

Wkh rxwsxw fxuuhqw ri eudnh frqwuro rxwsxw sruwεRXW8.2RXW80ζlv 833pDιfdq gulyh eudnh ghylfh gluhfwo|1

Define freely according to requirement, supporting following functions: Driver ready, driver fault, position reached, motor

zero speed, motor brake, motor speed reached, Z signal, maximum speed obtained in torque mode, motor brake, position

limiting, reference found.

The max. baudrate is 115.2KHz, use Kinco software to communicate with PC, or via free protocol to communicate with

Over-voltage protection, under-voltage protection, motor over-heat protection(I2T), short-circuit protection, drive over-

ZhljkwεNjζ

Brake chopper Yld zlulqj dq h{whuqdo eudnlqj uhvlvwruεpdlqo| lq txlfn vwduw dqg vwrs dssolfdwlrqζ

Brake chopper threshold GF:6Y ° 5YεGhidxow ydoxh/ Dgmxvwdeoh yld vriwzduhζ

Over-voltage alarming threshold GF;9Y ° 5Y

Power
57YGFЌ:3YGF

57YGF 4DεRswlrqdoζ

Current

Feedback signal
5833S2U εLqfuhphqwdo gliihuhqwldo 8Y hqfrghu ζ+vxlwdeoh iru IG4[60ΔΔ0333,ψ

Devroxwh ydoxh hqfrghuu+vxlwdeoh iru IG4[60ΔΔ0336,
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1.1.2 FD1X4S Technical Specifications Table 

 

NOTE: According to EN 61800-5-1:2007+A1:2017 

 

 

 

 

 

 

 

 

 

 

IG447V0ΑE0333 IG457V0Αΐ0333 IG467V0ΑE0333 IG477V0ΑE0333

Udwhg fxuuhqwεupvζ 5Arms
48DupvεXs wr 45Dupv zlwkrxw dx{loldu|

radiator )

25Arms(Up to 20Arms without auxiliary

radiator)

40Arms (Up to 30Arms without auxiliary

udgldwruζ

Peak current (PEAK) 8Ap 48Ap 80Ap 120Ap

0.3 0.3 0.6 0.9

Input specification

Input function

Output specification

Impulsive control

Output function

RS232

Protection function

Modbus/RS485

Can Bus

Ethercat

Model Parameter

Main supply voltage 57YGFЌ:3YGF

Rated output current

      Feedback signal 5833S2U+Lqfuhphqwdo gliihuhqwldo 8Y hqfrghu, Pdjqhwrhohfwulf hqfrghu

      Brake chopper Yld zlulqj dq h{whuqdo eudnlqj uhvlvwruεpdlqo| lq txlfn vwduw dqg vwrs dssolfdwlrqζιeudnh fkrsshu wkuhvkrog lv :6Y+Dgmxvwdeoh yld vriwzduh,1

      Brake chopper threshold GF:6Y ° 5YεGhidxow ydoxh/ Dgmxvwdeoh yld vriwzduhζ

      Over-voltage alarming threshold GF;6Y ° 5Y

      Under-voltage alarming threshold 4;Y°5Y

      Cooling method Natural air cooling

General functions

7 gljlwdo lqsxwvιfrpprq FRPL hqgι kljk ohyhoχ4518063YGFι orz ohyhoχ308YGFι pd{ iuhtxhqf|χ4NK}ιlqsxw lpshgdqfhχ8NƑ

εWkh eudnh prwru gulyhu lv d 6 gljlwdo lqsxwvζ

Define freely according to requirement, supporting following functions: Driver enable, driver fault reset, driver mode control, speed loop proportional control, positive

limit, negative limit, homing signal, reverse command, internal speed section control, internal positive section control, quick stop, start homing, active command, switch

electronic gear ratio, switch gain

2 digital outputs, brake motor driver is 1 digital signal output

Sxovh . gluhfwlrq FFZ.FZ skdvh D.skdvh Eε8YЌ57YζQrwhχIG4[7V0OΔ0333 vxssruw wklv ixqfwlrq

Define freely according to requirement, supporting following functions: Driver ready, driver fault, position reached, motor zero speed, motor brake, motor speed

reached, Z signal, maximum speed obtained in torque mode, motor brake, position limiting, reference found.

Ghidxow edxgudwh vhwwlqj lv 6;733ιwkh pd{1 edxgudwh lv 44815NK}/ xvh Nlqfr vriwzduh wr frppxqlfdwh zlwk SF/ ru yld iuhh surwrfro wr frppxqlfdwh zlwk frqwuroohu1

Over-voltage protection, under-voltage protection, motor over-heat protection(I2T), short-circuit protection, drive over-heat protection, etc.

      Weight(Kg)

Bus function

The max. baudrate is 115.2KHz, use Modbus RTU protocol to communicate with controller.

Support maximum 1MHz baudrate. Communicate with controller via CANopen protocol

Vxssruw FrH+FlD735 surwrfro, dqg FVS2FVY2SS2SY2SW2KP prghιFrppxqlfdwlrq vshhg 433P
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1.2 Product type description 

1.2.1 Model description of Servo Motors 

    SMC 60 S  -   0040  -  30 M  A K Ɋ 3 D S U-X

Identification Motor outlet mode

U

H: Three rows of 15 -  pin metal shell encoder sockets

U: Communication encoder socket

R: General aviation socket

Identification voltage class

D DχDC48V

Identification Encoder type

M

A: 2500 PRR Incremental Encoder

M : 16 bit single - turn magnetoelectric encoder

K: 16 bit Multi - turn absolute encoder

Identification Motor version number

K
K: K version

S: S version

Identification number of pole -pairs

3

3: 3 pole pair

4: 4 pole pair

5: 5 pole pair

Identification Band -type brake

B
A: No brake

B: With a brake

Identification Out -  of -  axis style

K
K: with keys

S: Optical axis

Identification Suffix

X
X: One to five digits ,letters ,oralphanumeric characters

Blank: Standard product

Identification Type

S
Sχsmall inertia
Dχmedium inertia

Identification Rated speed

30 3000rpm

Identification Rated power

0040

5χ5x10(W)

20χ20x10(W)
40χ40x10(W)
75χ75x10(W)

10χ10x10(W)

120χ120x10(W)
150χ150x10(W)

Identification Series model

SMC

SMCχSMC series

SMHχSMH series

SMS χSMS  series

Identification Flang

60 80χFlang size 80x80mm

110χFlang size 110x110mm

130χFlang size 130x130mm

60χFlang size 60x60mm

40χFlang size 40x40mm
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1.2.2 Driver description 

FD  1 2 4 S͠  C B-  000

Identification Serial number
FD FD series

Identification Voltage input specification
1 Input voltage  DC24~ 70V

Identification Rated output current

2

1χ5Arms

2χ15Arms (with fan )

3χ25Arms (with fan )

4χ40Arms (with fan )

Identification Control mode

C

LχRS232 RS485 Pluse 

CχRS232 CANopen 24V logic power
EχRS232 EtherCat 24V logic power

Identification Type

B
A: Do not directly drive the brake device

B: Can directly drive the brake device

Identification Software version
000 Software version number

Identification Low voltage Driver version

4
3: 3rd Generation Version

4: 4th Generation Version

Identification Software version

S

S means the encoder port of the driver is 
three rows for 15 pins (DB15), and no S 
means the encoder port of the driver is two 
rows for 16 pins

 

1.2.3 Cable 

MOT F ͠ 005 -  03 ͠ KL -  D

Identification Rated current

005

005χ5A

008χ8A

015χ15A

Identification Cable function category
MOT Motor power line

Identification Cable length

03

03χ3m

05χ5m

10χ10m

15χ15m

20χ20m

Identification Cable category

F
F: Flexible cable

Empty : ordinary cable
Identification Motor outlet type

KL
KL: 4PIN connection connector for 
direct outgoing motorKC5: Aviation Socket

D

Empty : Standard Cable

Identification Joint type

D: dedicated low -voltage servo line

SP: SP21 Series General Aviation Plug

B: brake -  power integrated cable

 

 

ENC O D F -  03 ͠ G U-  ǴǴ

Cable accessories

BT
BT: with battery ( for Multi - turn  absolute encoder )
Empty : no battery

Identification Motor end connector type

U C0: HF0 Series General Aviation Plug
U: 1394 connector

H: Three rows of 15pin metal casing encoder plugs

Identification Number of cable cores

G
G: 6 -  core cable
K: 16 core wire

Identification Cable function category
ENC Motor encoder line

Identification Cable length

03

03χ3m

05χ5m

10χ10m

15χ15m

20χ20m

Identification

Identification Version code
D Version code

Identification Cable category

F
F: Flexible cable

Empty : ordinary cable

Identification Driver Interface Type

O
O: Compact quick connector (matching FD 1X4)

C: Double row fifteen pin s(matching FD 1X3)
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BRA F  -  03 ͠ KL

Identification Cable function category
BRA Motor brake line

Identification Cable Type

F
F: Flexible cable

Empty : ordinary cable

Identification Cable length

03

03χ3m

05χ5m

10χ10m

15χ15m

20χ20m

Identification Motor outlet type
KL 2PIN brake joint

 

1.3 Nameplate  

1.3.1 FD1X3 

  

 

 

 

 

 

 

1.3.2 FD1X4S 
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Chapter 2 System installment requirements and precautions 

2.1 Driver mounting 

2.1.1 Mounting 

   

Figure2Ɋ1 FD123 driver size      Figure2Ɋ2 FD133 driver size 

 

 

 
Precaution  

Around driver, connection space need to be reserved, > 60mm.  
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                          Figure2ï3 D114S&FD124S driver size 
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                               Figure2ï4 FD134S driver size 

             

Figure2ï5 FD134 driver size  
Figure2ï6 FD144 driver size  
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                                 Figure2ï5 FD144S driver size 
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Precaution  

Around driver, connection space need to be reserved, > 70mm.  

 

 

 

Warning  

 ̧ Please carefully read and follow requirements of this menu. It can help you to 

correctly set up and operate driver, and make driver in the best performance  

 ̧ Please install it indoor of no rain and direct sunlight.  

 ̧ This product conform with EMC's standard 2014/30/EU and low -voltage 

standard 2014/35/EU(LVD)  

 ̧ Occasion (without Grinding fluid, Oil mist, Iron powder, cutting and etc)  

 ̧ Occasion (good ventilation, no Moisture, oil and water, no heat source such as 

stove)  

 ̧ Occasion without shock  

 ̧ Please do not use gasoline, thinner, Acid & Alkaline detergent, in order to 

avoid discoloration or damage  
 

 
 

 

2.2 Application requirements of driver 

 ̧ Please ensure this menu can be provided f or design engineer, operators and staffs (or 

machineζ who is responsible to adjust and use this product  

 ̧ Please ensure to follow requirements of this file all the time. And consider other accessory 

and module's file  

Please consider destination's law, and:  

ɋregulations and standards  

ɋtest organization and insurance company's regulation  

ɋnational specifications  

2.2.1 Transportation and saving conditions 

 ̧ Please ensure product do not overburn during the process of transportation and saving, 

including:  

ɋMechanic al load  

ɋnon -allowed temperature  
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ɋWater  

ɋCorrosive gas  

 ̧ Please use original package to save and transport. Original package provide efficient 

protection so as to avoid influence of general issues  

 

2.2.2 Technology requirements 

Must follow:  

 ̧ Specified connect ion and environment condition in product technology data and all of other 

connecting accessory's technology requirements. As long as product specification 

requirements are conformed, users are allowed to operate according to related safety 

regulations.  

 ̧ Please follow instructions and alerts in this product  

2.2.3 Operatorôs requirements 

 ̧ This product must be operated by electrical engineers who are familiar with instructions 

belowχ 

ɋElectrical control system's installation and operation  

ɋRegulations of operati ng safety project system  

ɋRegulations of accident protection and occupation safety  

ɋProduct using menu  

2.2.4 Environment requirements 

Environment  Requirement 

Working temperature 0 - 40Ņ (no ice) 

Working humidity 5 - 95%RH (no condensation) 

Storage temperature -10 - 70Ņ (no ice) 

Storage humidity 5 - 95%RH (no condensation) 

protection levels IP20 (refer to IEC60529) 

Installation site 
Indoor no sun, no corrosive gas, no inflammable gas, no oil and gas, no dust, dry lock 

(such as electric cabinet) 

Installation Method Vertical 

atmospheric pressure 86kpa~106kpa 

Pollution degree PD 2 
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Coolant type Air cooling εNormal atmospheric pressureζ 

Altitude 

Rated working altitude is below 1000 meters, when working altitude is above 1000 meters, 

every rise of 100 meters, need to drop 1.5% use, the maximum working altitude is 4000 

meters above sea level 

 

2.2.5 Precautions 

 

Alarm  

 ̧ Please follow menu's all required operation. And refer to figure 2 -7 to correctly 

install servo system.  

 ̧ In the case of use of an external brake resistor, provide adequate space around 

the brakeresistor since it can become very hot.  

 ̧ The installation orientation is vertical to provide sufficient convection air flow 

through t hecontroller housing.  

 



 

13 

 

> 10mm > 10mm > 10mm

> 20mm > 20mm

>
6
0

m
m

>
6
0

m
m

air intake air intake

air outlet air outlet

 

Figure 2Ɋ6 FD1x3 drive installation interval 
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> 10mm > 10mm > 10mm

air intake air intake

air outlet air outlet

>
6
0

m
m

> 20mm

>
6
0

m
m

> 20mm

 

Figure 2Ɋ7 FD1x4S drive installation interval 
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Note  

 ̧ Tightly fasten the screws that fix the motor ψ 

 ̧ Make sure to tightly fasten all fixed points when fixing the driver ψ 

 ̧ Driver & motor power cable, brake cable and encoder cannot be over 

stretching ψ  

 ̧ Use a coupling shaft or expansion sleeve to ensure that both the motor shaft 

and equipment shaft are properly centered ψ 

 ̧ Avoid anything strange into driver. When Screw, metals shavings and other 

things with conductivity or flammability enter into driver, it might causes  

fire or electric shock. For safety, do not use any damaged servo driver or 

anydriver with damaged parts ψ 

2.3 Servo motor wire diagram 

2.3.1 SMC40S-0005-30MAK-5DSUε40flangeι50Wιwithout brakeιMagnetoelectric encoderζ 
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2.3.2 SMC40S-0010-30MAK-5DSUε40 flangeι100Wιwithout brakeιMagnetoelectric encoderζ 

 

 

 

 

2.3.3 SMC40S-0010-30MBK-5DSUε40 flangeι100Wιwith brakeιmagnetoelectric encoderζ 
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2.3.4 SMC60S-0020-30AAK-4DKH ε60 flange, 200 W, with brake, incremental encoder ζ 

 

2.3.5 SMS60S-0020-30KAK-ε60 flangeι200Wιwithout brakeιabsolute encoderζ 
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2.3.6 SMC60S-0020-30MAK-3DSU ( 60 Flange, 200 W, without Brake, Magnetoelectric encoder ) 

                                                  

2.3.7 SMC60S-0020-30MBK-3DSU ( 60 Flange, 200W, With Brake, Magnetoelectric encoder ) 
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 2.3.8 SMS60S-0020-30KAK-3DKU ( 60 Flanges, 200W, without Brake, absolute encoder ζ 

  

2.3.9 SMS60S-0020-30KBK-3DKU ( 60 Flanges, 200W, With Brake, absolute Encoderζ 
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2.3.10 SMC60S-0040-30AAK-3DKH ( 60 Flange, 400W, without Brake, incremental encoder ) 

2.3.11 SMC60S-0040-30ABK-3DKH ( 60 Flange, 400W, With Brake, incremental encoder  ) 

 

 

2.3.12 SMC60S-0040-30MAK-3DSU  ( 60 Flanges, 400W, without Brake, Magnetoelectric encoder  ) 
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2.3.13 SMC60S-0040-30MBK-3DSU  ( 80 Flange, 400W, With Brake, Magnetoelectric encoder  ) 

 

 

2.3.14 SMS60S-0040-30KAK-3DKU( 60 Flange, 400W, without Brake, absolute position ζ 

                                             

2.3.15 SMS60S-0040-30KBK-3DKU( 60 Flange, 400W, with Brake, Absolute Encoder ) 

1.  
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2.3.16 SMC80S-0040-30AAK-3DKH ε80 flangeι400Wιwithout brakeιincremental encoder ζ 

 

 

 

 

2.3.17 SMC80S-0040-30ABK-3DKH ( 80 Flange, 400 W, With Brake, Incremental Encoder )ζ 
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2.3.18 SMS80S-0040-30KAK-3DKU ( 80 Flange, 00 W, without Brake, absolute Encoder )ζ 

                                        

 2.3.19 SMS80S-0040-30KBK-3DKU ( 80 Flange, 400W, With Brake, absolute encoder ζ 
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2.3.20 SMC80S-0075-30AAK-3DKH ( 80 Flange, 750 W, without Brake, incremental encoder ζ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.3.21 SMC80S-0075-30ABK-3DKH(80 flangι750Wιwith Brakeιincremental encoder) 
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2.3.22 SMC80S-0075-30MAK-3DSU(80 flangι750Wιwithout BrakeιMagnetoelectric encoder) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.3.23 SMC80S-0075-30MBK-3DSU(80 flangι750Wιwith BrakeιMagnetoelectric encoder) 
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 2.3.24 SMS80S-0075-30KAK-3DKU(80 flangι750Wιwithout Brakeιabsolute encoder) 

2.3.25 SMS80S-0075-30KBK-3DKU(80 flangι750Wιwith Brakeιabsolute encoder) 
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2.3.26 SMH110D-0120-30AAK-4DKR(110 flangι1260Wιwithout Brakeιincremental encoder) 

 

 

2.3.27 SMH110D-0120-30ABK-4DKR(110 flangι1260Wιwith Brakeιincremental encoder) 
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2.3.28 SMC130D-0120-30AAK-4DKR(130 flangι1200Wιwithout Brakeιincremental encoder) 
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2.3.29 SMC130D-0120-30ABK-4DKR(130 flangι1200Wιwith Brakeιincremental encoder) 

 

2.3.30 SMC130D-0150-30AAK-4DKR(130 flangι1.5KWιwithout Brakeιincremental encoder) 
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2.3.31 SMC130D-0150-30ABK-4DKR(130 flangι1.5KWιwith Brakeιincremental encoder) 

                                        

2.4 Servo motor torque curve 

The driver has an overload capacity of up to three times. The overload time can be calculated according to the IT 

time of the motor. The three times overload time is 0.19 * t. Double overload time: 0.29 * t. For example, if the IT 

time of the motor is 20 seconds, the duration of double overload is 6 seconds and the duration of triple overload is 4 

seconds. 

 

2.4.1 50W servo motor torque curve      
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2.4.2  100W servo motor torque curve 

 

 

 

 

 

 

 

 

 

 

 

 

2.4.3 200W servo motor torque curve 
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2.4.4 400W servo motor torque curve 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.4.5 750W servo motor torque curve 
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2.4.6 1.2kW servo motor torque curve 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.4.7 1.5kW servo motor torque curve 
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2.5 Servo motor installation 

2.5.1 Installation requirement 

 

Alarm  

 ̧ Please install it indoor of no rain and direct sunlight.  

 ̧ Please do not use this product in the corrosive environment (Hydrogen sulfide, 

Sulfurous acid, Chlorine, Ammonia, Sulfur, Chlorinated gas, Acid, Al kaline, Salt, 

etc), flammable gas, combustible and etc.  

 ̧ Occasion (without Grinding fluid, Oil mist, Iron powder, cutting and etc).  

 ̧ Occasion (good ventilation, no Moisture, oil and water, no heat source such as 

stove).  

 ̧ Occasion which is easy to be checked and cleaned.  

 ̧ Occasion without shock.  

 ̧ Please do not use motor in the closed environment.  

 ̧ For installation spacing, please follow the requirements of this manual. Using 

life of motors depend on level of working environment.  
 

 

2.5.2 Environment conditions 

Environment Conditions 

Working 

temperature 
0ɫЌ40ɫεno iceζ 

Working 

humidity 
5Ќ95%RHεno condensationζ 

Storage 

temperature 
-10ɫЌ70ɫεno iceζ 

Storage humidity 5Ќ95%RHεno condensationζ 

vibration Running, less than 49m/s2ε5Gζ stopping, less than 24.5m/s2ε2.5Gζ 

collisin Less than 98m/s±ε10G) 

Protection level IP65εExcept for shaft hollow partιpart of motor connector connect terminal ζ 

Atmodpheric 

pressure 
86kpa~106kpa 
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Altitude 
Rated working altitude is below 1000m, when working altitude is above 1000m, every rise of 

100m, the power drops by 1.5%, the highest altitude is 4000 m 

2.5.3 Precautions 

Item  Description  

Stain 

proofing 
Please wipe anti-rust agent on the motor's shaft and then make some anti-rust treatments. 

Installation 

method 

Improper installation method will cause damage of motor's encoder. Please note the following 

during the installation process: 

ǒ When operators installation pulleys on the servo motor shaft with key, it is necessary to use 

screw hole. In order to install pulleys, operators need to insert double-headed nail into screw 

holes and use washers on the surface of coupled end. Then use nuts to fix into pulleys gradually.  

ǒ For servo motor shaft with keys, Operator need to use screw hole on the shaft to install. For 

motors shaft with no key, operators need to use friction coupling or other analogous methods.  

ǒ When operators need to disassemble pulleys, operators need to use pulley remover so as to 

make shaft avoid strong impact of load. 

ǒ In order to make it more safe, it is necessary to install protection cover or some analogous 

equipment in rotation area. For example, pulleys installed on the shaft. 

Centering  

ǒWhen it is connected with machine, please use coupling and make shaft center of servo motor 

and machine stay in a line. When operators install servo motors, please achieve requirements of 

centering accuracy. If centering is not accurate, there will be shock and sometimes it will make 

bearings and encoders. 

Installation 

direction 
ǒ Servo motors can be installed in vertical or horizontal direction. 

Oil & water 

solution  

When it is used in the occasion with drops, please use after make sure protection level of servo. 

When oil will drop into shaft penetrating part (beside shaft penetrating part, please choose servo 

motors with oil seal. The using condition of servo motors with oil seal: 

ǒ Make sure the oil level is lower than month of oil seal. 

ǒ Please use when oil seal make sure that oil splash degree is good. 

ǒ When servo motors are installed in vertical upward direction, please avoid oil accumulating in 

the month of oil seal.  

Cable Please do not make cable bending or pull the cable. When using it, please do not make it too tight. 
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Connector 

In terms of connectors, please note the following: 

ǒ When connectors are connected. please make sure there is no foreign body such as trash or mental 

slices.  

ǒ When connectors are connected into servo motors, please connect to one side of servo motor's 

main circuit cable and make sure ground cable of main cable connecting stably. If operators first 

connect one side of encoder cable, then, encoder may have some faults because of voltage 

difference between PEs.  

ǒ During the process of wiring, please make sure pin arrangement is correct.  

ǒ Connector is made of resin. Please do not add pressure to avoid damage of connectors. 

ǒ When handling operations is done (cables are connected), please hold main body of servo motors. 

If operators just hold cable to handle, it may cause connectors damage or make cable cut off. 

ǒ If operators use bend cable, please do not add pressure to connectors during the process of wiring. 

If pressure is added to connectors, it will cause connector damage. 

 

2.5.4 Installing  oil  seal 

 

The bearing  of  the  motor  has double  flour  dustproof  effect.  Assembling  oil  seal will  increase  t

he loss of  the  motor  and  lead  to  the  decrease  of  motor  efficiency.  If  it  is not  necessary to  install  oi

l seal, it  is not  recommended  to  install  oil  seal. Before  assembling  the  oil  seal, please ensure  that  t

he mounting  hole  groove  and  the  oil  seal are free  of  debris,  oil  stain,  dust,  etc. During  assembly,  p

lease fill  the  oil  seal The Lips with  high -

temperature  grease (Greatwall  HR12 and  grease with  temperature  resistance  of  150 degrees  are r

ecommended)  so as to  enhance  the  lubrication  and  temperature  resistance  performance  and  incr

ease the  sealing  waterproof  effect  of  the  oil  seal. When  paying  attention  to  water  and  oil  preventi

on,  the  oil  seal is installed  outward  from  the  side of  the  self-

tightening  spring  (i.e. the  side with  groove).  Please refer  to  the  following  steps  to  correctly  install  

the  oil  seal. 

  

1. Apply  high -temperature  lubricating  grease evenly  on  the  sealing  ring  of  the  oil  seal lip.  

2.Turn  the  side of  the  oil  seal with  groove  outward  to  ensure  that  the  oil  seal is perpendicular  

to  the  machine  shaft,  and  push  the  oil  seal into  the  cavity  with  uniform  force  application . 

3.After  successfully  installing , check  whether  the  oil  seal is inclin ed. The oil  seal needs  to  be attach

ed to  the  motor  bearing  cover.  The lip  of  the  oil  seal needs  to  be completely  closed  to  ensure  the  

tightness  of  the  oil  seal.  
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Chapter 3 Interface and wiring 

3.1 Components name 

3.1.1 FD123 

 

Figure3Ɋ1 FD123 Components name  

Table 3-1 LED description 

Upper left LED RUN When driver is ready, LED is blinking. Related with OUT3. 

Upper right LED ERR When driver is on error state, LED is blinking. Related with OUT4. 

Lower left LED BUS When message is transmitted on CAN bus, LED is blinking.  

Blinking frequency is related with transmission speed. 

Lower right LED PWR Driver power on 
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3.1.2 FD133 driver 

 

Figure3ï2 FD133 Components parts 1 

Table 3-2 State LED 

Upper left LED RUN When driver is ready, LED is blinking. Related with OUT3. 

Upper right LED ERR When driver is on error state, LED is blinking. Related with OUT4. 

Lower left LED BUS When message is transmitted on CAN bus, LED is blinking.  

Blinking frequency is related with transmission speed. 

Lower right LED PWR Driver power on 
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X1χBus 
communication 

connector
Communicat
ion setting 

switch

Status 
LED

X2χRS232 connector

X3χIO 
connector

X4χEncoder 
connector

X5χPower supply & 
motor connector

U

V

W

PE

RB-

DC-

DC+/ RB+

Motor 
power line

Brake 
resistor

Dc power 
supply

3.1.3 FD114S/FD124S driver 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Table 3-3 State LED 

First LED BUS 

̂greeñ 

When message is transmitted on CAN bus, LED is blinking.  

Blinking frequency is related with transmission speed.  

Second LED PWR̂red̃ Driver power on  

Third  LED RUN

̂greeñ 

When driver is ready, LED is blinking. Related with OUT3.  

Fourth   LED ERR̂ red̃ When driver is on error state, LED is blinking. Related with 

OUT4. 

 

 

 

 

Figure3ï3 FD114S/FD124S Components parts 
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Status LED

X2χRS232 
connector

X3χIO  
connector

X4χEncoder 
conector

U

V

W

PE

RB-

DC-

X1χBus 
communication 

connector

Communication 
setting switch

DC+/ RB+

X5χPower supply 
& motor connector

Motor power 
line

Brake resistor

Dc power 
supply

 

3.1.4 FD134S/FD144S driver 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Table 3-4 State LED 

First LED BUS 

̂greeñ 

When message is transmitted on CAN bus, LED is blinking.  

Blinking frequency is related with transmission speed.  

Second LED PWR̂red̃ Driver power on  

Third LED  RUN

̂greeñ 

When driver is ready, LED is blinking. Related with OUT3.  

Fourth  LED  ERR̂ red̃ When driver is on error state, LED is blinking. Related with 

OUT4. 

 

 

                                Figure3ï4 FD134S/FD144S  Components parts  
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3.2 External wiring 

3.2.1 FD123 External wiring diagram 

U
V
W
PE

דט כּ

 כּ ᵸ

Ἰ כּ

RS232ѩᴭ

כּטֺ

24VЌ70V
ӗּכּכ◊

24VἸ ◊כּ

+ -

+-
 

Figure 3Ɋ5 FD123 External wiring diagram 

RS232 cable 

24V brake power 

Motor brake cable 

Motor encoder cable 

Motor power cable 

Brake resistor 

24V-70V power 
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3.2.2 FD133 External wiring diagram 

U
V
W
PE

דט כּ

 כּ ᵸ

Ἰ כּ

RS232ѩᴭ

כּטֺ

24VЌ70V
ӗּכּכ◊

24VἸ ◊כּ

+ -

 

Figure 3Ɋ6 FD133 External wiring 

3.2.3 FD1X4S External wiring diagram 

  

RS232 cable 

24V brake power 

Motor brake cable 

Motor encoder cable 

Motor power cable 

 

24V-70V power 

Brake resistor 
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Figure 3ï7 FD1X4S External wiring 1 
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Note  

 ̧ If the driver model is FD1X4S -ΔB, it can directly drive the brake device, and the 

6-pin and 11 -pin of the X3 port are br+and br - ; If the driver model is FD124-Δ

A, the band brake device cannot be driven. The 6 pins and 11 pins of the X3 

port are OUT 2+and IN4 respectively.  

 ̧ For fuse specification selection, please refer to Appendix 4.  

 

 

 

 

 

 

 

 

 

 

3.3 Bus communication portεX1ζ 

 

Port 

name  

EtherCAT CANopen  RS485 

Product  FD123-EA-000 

FD133-EA-000 

FD114S-EB-000 

FD124S-EA-000 

FD124S-EB-000 

FD134S-EB-000 

FD144S-EB-000 

FD123-CA-000 

FD123-CC-000 

FD133-CA-000 

FD133-CC-000 

FD114S-CB-000 

FD124S-CA-000 

FD124S-CB-000 

FD134S-CB-000 

FD144S-CB-000 

FD123-LA-000 

FD133-LA-000 

FD114S-LB-000 

FD12S4-LA-000 

FD124S-LB-000  

FD134S-LB-000  

FD144S-LB-000 
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Pin 

definition  8
7
6
5
4
3
2
1

X

TD-

X
X

RD-

RD+

TD+

X

8
7
6
5
4
3
2
1

X

TD-

X
X

RD-

RD+

TD+

X

 

8
7
6
5
4
3
2
1

X

X
X
X

CAN_L
CAN_H

CAN_GND

X

8
7
6
5
4
3
2
1

X

X
X
X

CAN_L
CAN_H

CAN_GND

X

 

8
7
6
5
4
3
2
1

TX-

X

GND

RX-
RX+

X

TX+

8
7
6
5
4
3
2
1

TX-

X

GND

RX-
RX+

X

TX+

X

X

 

 
Note  

Diagram above is network port definition of driver, instead of communication 

cable. Please note and avoid wrong welding.  

3.4 RS232 portεX2ζ 

  

8
7
6
5
4
3
2
1

GND

RX
X
X

X
X

TX

X

 

Pin No  Pin name  Pin function  

3 TX Transmit data  

4 GND Signal ground  

6 RX Received data  

Others  NC Reserved 
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3.4 RS232 port (X2) 

 

3.5 External input&outputεX3ζ 

3.5.1 FD123/FD133 Driver X3 Interface Definition 

1

2

3

4

5

6

7

8

A
9

10

11

12

13

14

15

16

B
24VS

GNDS

PUL+

PUL-

DIR+

DIR-

OUT5+

OUT5-

COM I

IN1

IN2

IN3

IN4

OUT1+

OUT2+

COM O
 

Pin No.  Symbol  Function  

1 24VS Brake power input  

Voltage χ24VDC 

Currentχ1A 

2 GNDS 

3 PUL+ Analog input function is only suitable to 

types below:  

FD123-CC-000 

FD133-CC-000 

 

Pulse input is suitable for other types:  

Input voltage χ3.3VЌ24V 

Max frequency χ500KHz 

AIN1+  

4 PUL- 

AIN1 - 

5 DIR+  

AIN2+  

6 DIR- 

AIN2 - 

7 OUT5+  Brake output  

8 OUT5- 

9 COMI  Common terminal of digital input  

10 IN1  Digital signal input  

High level χ12.5VDC~30VDC  

Low levelχ0VDC~5VDC  

Input frequency χ<1KHz  

11 IN2  

12 IN3  

13 IN4  

14 OUT1+  Digital signal output  

8
7
6
5
4
3
2
1

GND

RX
X
X

X
X

TX

X

 

Pin num  Pin name  Pin function  

3 TX The driver sends data  

4 GND Signal ground  

6 RX The driver receives data  

Other  NC reserve 
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15 OUT2+  Max output current χ100mA  

16 COMO  Output common terminal  

 

 
 

 

Note  

 ̧ Since X3 of FD1x3 driver is a crimp terminal, it is suggested that the cross -

sectional area of the conductor of the terminal should be within 0.2 ~ 1.5 mm, 

and the stripping length should reach 8 mm. after the wire core is folded into 

bundles, it should be inserted into the crimp terminal.  

 ̧ The  X3 terminal wiring specification range is 16~24AWG . 
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Digital signal 
input

 

 

 

 

Input common 
terminal

Impulse 
command
ε< 500KHzζ

PUL+ / CW+ / A+

PUL- / CW- / A-

DIR+ / CCW+ / B+

DIR- / CCW- / B-

Power Input 
for Holding 

Brake

Brake Power 
Input +
Brake Power 
Input -

Digital signal 
outputDriver alarm

Drive ready

Output common

Motor brake Digital signal 
output

IN1

IN2

IN3

IN4

10

11

12

13

9 OUT1+

OUT2+

COMO

14

15

16

PUL+

PUL-

DIR+

DIR-

3

4

5

6

24VS

GNDS

1

2

OUT5+

OUT5-

7

8

Pulse mode : only applicable to
FD1X3-XA-000

Analog 
speed 

command
AIN 1+

AIN 1-

AIN 2+

AIN 2-

3

4

5

6

Aμ
D 

Con
versi
on

Maximum 
torque limit

Analog speed mode : only applicable  
To FD1X3-CC-000

Analog 
torque 

command
AIN 1+

AIN 1-

AIN 2+

AIN 2-

3

4

5

6

Aμ
D 

Con
versi
on

Maximum 
torque limit

Simulation torque mode : only  
applicable to  FD1X3-CC-000

 
 

Figure3Ɋ8 FD123/FD133 Driver control wiring 

 

Note  

 ̧ In diagram 3 -5, it shows wiring with default IO function. More IO functions can 

be defined by software.For more details of IO functions, please refer to related 

chapter.  

 ̧ For digital output, in diagram 3 -5, it just shows NPN wiring. In diagram 3 -6, it 

shows PNP wiring.  

 

ᵸט       
X0

COM
PLC

Ẉכּ Ԅῶᾦ

OUT1+

OUT2+

COM O

14

15

16

 

Figure3Ɋ9 PNP input wiring  

Driver PLC 

High level input valid 
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3.5.2 FD1X4S Driver X3 Interface Definition 

 

 

 ̧ Note  

 ̧ If the driver model is FD1X4S -ΔB, it can directly drive the brake device, and the 

6-pin and 11 -pin of the X3 port are br+and br - ; If the driver model is FD1X4S -

ΔA, the band brake device cannot be driven, and the 6 pins and 11 pins of the 

X3 port are OUT2 θ+and IN4 respectively.  

 

 

 

 

 

 

 

 

 

 

 

                               

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3͠10 FD1x4S-Ǵ B-000 Driver control wiring diagram 

Figure 3͠11 FD1x4S-Ǵ A-000 Driver control wiring diagram 
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3.5.2 FD1X4S Driver X3 Interface Definition 

 

 

 No.  Pin name  Function  

1 PUL+ FD1X4S-L Γ-000 supports pulse 

input function and does not 

support 24V logic power input. 

FD1X4S-CΓ-000 and FD1X4S -EΓ-

000 support 24V logic power input 

and do not support pulse input 

function.  

Pulse input  

Input voltage χ3.3VЌ24V 

Max frequency χ500KHz 

Logic power input  

Input voltage: 24V  

Maxcurrent: 1A  

2 PUL- 

3 DIR+  

4 DIR- 

5 OUT1+  Digital signal output Maximum 

output current: 100mA  
6 OUT2

+/ BR+  

O

UT2+  

BR

+  

Brake output  

7 COMI  Input common terminal  

8 IN1  Digital signal input High level: input 

voltage 12.5VDC~30VDC       

Input current :4 -20mA  

Low level: 0VDC~5VDC  

Input frequency:<1KHz  

9 IN2  

10 IN3  

11 IN4/B

R- 

IN

4 

BR

- 

Brake output  

FD114S-ΔE-000&FD124 S-ΔE-000ι 

The output current of the brake port 

is 0.5A 

A B

1

2

3

4

5

6

7

8

9

10

11

12

PUL+/24V+

PUL-/24V-

DIR+

DIR-

OUT1+

BR+

COMI

IN1

IN2

IN3

BR-

COMO

FD1X4S-ǴB- 000

A B

1

2

3

4

5

6

7

8

9

10

11

12

PUL+/24V+

PUL-/24V-

DIR+

DIR-

OUT1+

OUT2+

COMI

IN1

IN2

IN3

IN4

COMO

FD1X4S-ǴA- 000
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Note  

 ̧ Figs. 3-10 and 3 -11 show the wiring with default IO functIOns, and more io 

functions can be defined by the upper computer debugging software. For 

more details on IO functions, please refer to the relevant sections.  

 ̧ Figures 3 -10 and 3 -11 only show NPN connection mode for digital signal 

output, and figure 3 -12 shows PNP connection mode.  

 

 

 

Figure 3ï12  PNP Mode Wiring Diagram  

 

 

 

 

 

 

 

 

 

 

 

 

FD134S-ΔE-000ιThe output current 

of the brake port is 0.8A  

FD144S-ΔE-000 ι  The output 

current of the brake port is 1A  

12 COMO  Output common  
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3.6 Encoder inputεX4ζ 

3.6.1 FD123/FD133 Driver X4 Interface Definition 

Pin definition (motor with incremental encoder)  

+ 5V

A+

B+

Z+

U+

V+

W+

X

GND

A-

B-

Z-

U-

V-

W-

 

Pin No.  Symbol  Function  

1 5V+  5V output  

2 A A phase of encoder input  

3 B B phase of encoder input  

4 Z Z phase of encoder input  

5 U U phase of encoder input  

6 V V phase of encoder input  

7 W W phase of encoder input  

8 -  Undefined  

9 GND Ground of encoder signal  

10 /A  A phase of encoder input  

11 /B B phase of encoder input  

12 / Z C phase of encoder input  

13 /U  D phase of encoder input  

14 /V  E phase of encoder input  

15 /W  F phase of encoder input  

 

Pin definition (motor with communication encoder ζ 

+ 5V

SD

GND

/ SD

 

Pin No.  Symbol  Pin function   

1 5V+  5V output  

7 SD Data signal positive  

9 GND Encoder signal ground  

15 / SD Data signal negative  
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3.6.2 FD1X4S Driver X4 Interface Definition 

Pin definition (motor with incremental encoder)  

10

5

1

6

11

15

 

Pin No.  Symbol  Pin function  

2 GND Encoder signal ground  

13 /A  Encoder A phase signal input  

12 /B Encoder B phase signal input  

11 /Z  Encoder Z phase signal input  

5 /U  Encoder U phase signal input  

15 /V  Encoder V phase signal input  

14 /W  Encoder W phase signal input  

1 5V+  5V Power Supply Voltage Output  

8 A Encoder A phase signal input  

7 B Encoder B phase signal input  

6 Z Encoder Z phase signal input  

4 U Encoder U phase signal input  

10 V Encoder V phase signal input  

9 W Encoder W phase signal input  

 

 

 

 

 

 

 

 

Pin Definition  (Motor with Magnetoelectric encoder )  

Pin No.  Symbol  Pin function  

2 GND Encoder signal ground  

15 MA_N- Negative end of data signal  

14 SLO_N- Negative end of data signal  

1 ENC5V 
5V Power Supply Voltage 

Output  

10 MA_P+  Positive end of data signal  
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10

5

1

6

11

15

 

9 SLO_P+  Positive end of data signal  

 

 

Pin Definition  (Motor with Absolute value encoder )  

10

5

1

6

11

15

 

Pin No.  Symbol  Pin function  

2 GND Encoder signal ground  

14 /SD Negative end of data signal  

1 ENC5V 
5V Power Supply Voltage 

Output  

9 SD Positive end of data signal  

 

3.7 Motor/power εX5ζ 

3.7.1 FD123 X5 pin definition 

Symbol  Pin function  

PE Servo motor UVW phase out and motor ground  

W 

V 

U 

RB- External brake resistor input  

RB+ 

NC Reserve 
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PE

W

V

U

RB-

RB+

NC

DC-

DC+
 

DC- Driver power input  

 DC+ 

3.7.2 FD133 X5 pin definition 

PE

W

V

U

RB-

DC-

DC+
/ RB+

 

Symbol  Pin function  

PE Servo motor UVW phase out and motor ground  

W 

V 

U 

RB- External brake resistor input  

DC- Driver power input negative  

DC+/

RB+ 

DC+ Driver power input positive  

RB+ External brake resistor input  

 

 
Note  

The  FD123 driver X5 terminal wiring specification range is 12~26AWG, and 

the FD133 driver X5 terminal wiring specification range is 12~22AWG   

 

3.7.3 FD114S/FD124S  X5 pin definition 

Symbol  Pin function  

PE Servo motor UVW phase out and motor ground  

W 

V 

U 

RB- External brake resistor input  

DC- Driver Power Input Negative  
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PE

W

V

U

RB-

DC-

DC+/ RB+

 

DC+ 

/RB+  

DC+ Driver Power Input Positive  

RB+ External brake resistor input  

 

3.7.4 FD134S/FD144S X5 pin definition 

 

 

 

 

 

Note  

 ̧ The  FD134S driver X5 terminal wiring specification range is 12~22AWG, and 

the FD144 S driver X5 terminal wiring specification range is 8~20AWG . 

 ̧  FD1X3 and FD1X4 S low -voltage servo drivers can use cables greater than or 

equal to 5 mm as power cables . 

 

PE

W

V

U

RB-

DC-

DC+
/ RB+

 

Symbol  Pin function  

PE Servo motor UVW phase out and motor ground  

W 

V 

U 

RB- External brake resistor input 

DC- Driver power input negative 

DC+/

RB+ 

DC+ Driver power input positive 

RB+ External brake resistor input 



 

57 

 

Chapter 4 KincoServo software introduction 

This chapter will introduce how to use KincoServo software adjust and configure servo driver.  

 

Figure0Ɋ1 Software main window 

4.1 Fast start 

4.1.1 Language configuration 

Language can be switched between English and Chinese via menu item Tools -> Language . 

4.1.2 Opening and saving project files 

Create a new project file via menu item File -> New , or by clicking the button.  

Open an existing project via menu item File -> Open , or by clicking the button and selecting 

a .kpjt file.  

Save a project via menu item File -> Save, or by clicking the button and saving as a .kpjt file.  
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Note  

Only the windows (object list, scope etc.) are sa ved-parameters in the controller 

fdqɏw eh vdyhg lq wklv zd|1 

4.1.3 Start communication 

Click menu item Communication -> Communication settings . The following window appears:  

 

Figure0Ɋ2 Communication setting 

Select the right COM port (if it ɏs not shown click the ɒRefreshɓ button), baud rate and COM 

ID (Node ID), and then click the "OPEN ɓ button.  

Once communication has been established with the controller, communication can be opened 

or c losed by clicking the  button.  

4.1.4 Node ID and baud rate 

If more than one controller is being used in an application, you may need different node ID for 

different controllers in order to distinguish among them.  

The controller ɏs Node ID can be changed vi a menu item Controller -> Controller Property . 

Internal address Type Name  Value  Unit 

100B0008 Usigned8 Node ID  DEC 

2FE00010 Usigned16 RS232 baud rate   Baud 

 

 
Note  

Node  ID and baud rate setting are not activated until after saving and rebooting.  

4.1.5 Object (addιdeleteιhelp) 

Open any window with an object list, move the mouse pointer to the object item and right click. 

The following selection window appears:  
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Click Add  and double click the required object from the Object Dictionary . The selected object 

is then added to the list.  

Click Delete . The selected object is removed from the list.  

Click Help  to read a description of the selected object in the Object Dict ionary . 

4.2 Initialize, save and reboot 

Click Driver -> Ini tialize/Save . The following window appears:  

 

Figure0Ɋ3 Initialize, save, reboot 

Click the corresponding item to finish the necessary operation.  

 
Note  

After completing the Init Control Parameters , the Save Control Parameters and 

Reboot buttons must be clicked to load the default control parameters to the 

controller.  

 

Figure0Ɋ4 Load Firmware  

Click Load File  to select the firmware file (.servo) and then click Download  to start loading 

firmware to the controller.  



 

60 

 

 
Note  

Do not switch off the power or disconnect the RS232 cable during firmware loading. If 

the download process is interrupted, first reset controller power. Then select the 

firmware file and click the Download button, and finally start RS232 communication.  

 

4.3 Read/write driver configurations 

This function can be used to read / write multiple parameters simultaneously for large 

production lots, in order to avoid setting the controller parameters one by one.  

4.4.1 Read setting from controller 

Click Tools ->  Read  Driver Configurations  from  Controller or click the   button. The 

following window appears.  

 

Figure0Ɋ5 Read driver configuration 
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Click Open File  to select a parameter list file (.cdo). The parameter appears in the window. Click 

Read Settings from Controller  to get the Drive Value  and Result , and then click Save to File  to 

save the settings as a .cdi file.  

 

 
Note  

The .cdo file defines which object v zloo eh uhdg rxw/ exw li wkh remhfw grhvqɏw h{lvw 

lq wkh frqwuroohu/ wkh uhvxow zloo eh ɒIdovhɓ+glvsod|hg lq uhg,1 

4.4.2 Write settings to controller 

Click Tools -> Write  Driver  Configuration s or click the   button.  

The following window appears:  
 

 

Figure0Ɋ6 Write driver configuration 

Click Open File  to select a parameter settings file (.cdi). The parameter settings appear in the 

window.  

Click Write to Controller  to get the Check Value  and Result . The ɒFalseɓ Result means the 

value has not been written successfully, probably because the object doesn ɏt exist in the controller.  
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Click Save in EEPROM  and Reboot  to activate all parameters.  

 

 
Note  

Before write setting to driver, please cancel driver enable. If driver is enabled, some 

object cannot be written.  

4.4 Digital IO functions 

Click menu item Controller -> Digital IO Functions  or click the   button. The following 

window appears. Function and polarity are shown as defaults here.  

 

 

Note  

FD1X3 support 4 road digital inputs (Din1, Din2, Din3, Din4) and 2 road digital 

outputs (Dout1, Dout2).  

 

 

Figure 0Ɋ7 Digital input output  
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4.4.1 Digital input 

 

Figure0Ɋ8 Digital input 

Function : Click  to select DIN function setting, click  to delete the DIN fu nction setting.  

Simulate : Simulates the digital input active hardware signal.  

Real : Shows the real digital input hardware status.  

Polarity χ means Internal is set to 1 by ɒactiveɓ signal. means Internal is set to 1 by 

ɒinactiveɓ signal.  

Internal χThis is the result of Simulate, Real and Polarity via the logic formula:  

Internal=(Real OR Simulate) XOR (NOT Polarity)  

means ɒactiveɓ, logic status of the selected function is 1 ψ means ɒinactiveɓ, logic status 

of the selected function is 0.  

 

 

DIN function Description 

Enable 

Controller enabling 

1: Enable controller (Controlword=Din_Controlword(2020.0F) , default value=0x2F) 

0: Disable controller (Controlword = 0x06) 

Reset errors Sets the Controlword to reset errors, active edge: 0 -> 1 

Operation mode 

sel 

Operation_Mode selection 

1: Operation_Mode=EL.Din_Mode1 (2020.0E), default value = -3 

0: Operation_Mode=EL.Din_Mode0 (2020.0D), default value = -4 

Kvi off Velocity control loop integrating gain off 

Limit+ Positive / negative position limit switch input for ɒnormally closedɓ limit switches  

0: position limit is active, the related direction is blocked Limit- 

Home signal Home switch signal, for homing 

Invert Direction Inverts command direction in the velocity and torque mode 

Din Vel Index 0 

Din_Speed Index in the DIN speed mode Din Vel Index 1 

Din Vel Index 2 

Quick stop 
Sets the controlword to start quick stop. After quick stop, the controlword needs to be set to 0x06 

before 0x0F for enabling (if the enable function is configured in Din, just re-enable it) 
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Start homing 
Starts homing.  Only makes sense if the controller is enabled. The controller returns to the 

previous operation mode after homing. 

Activate 

command 

Activates the position command. Controls bit 4 of the Controlword, e.g. 

Controlword=0x2F->0x3F 

Pre enable 

For safety reasons, Pre_Enable can serve as a signal for indicating whether or not the entire 

system is ready. 

1: controller can be enabled 

0: controller can not be enabled 

 

Note  

Relative/Absolute position control select (2020.0F) default setting is 0x2F. For 

Control word definition, please refer to Chapter 6.1.  

4.4.2 Digital output 

 

Figure0Ɋ9 Digital output 

Function : Click  to select the OUT function setting. Click  to delete the OUT function 

setting  

Simulate : Simulates the digital output function logic status 1.  

Real : Shows the real digital input hardware status. This is the result of Simulate, Polarity 

and Logic State, means that digital input is ON, means that digital input is OFF.  

Polarity : Inverts the logic status of the digital output function.  

1  means Real  physical digital output is set to ON by digital output function logic status 

1 

0  means Real  physical digita l output is set to ON by digital output function logic status 

0 

Real : This is the result of Simulate, Polarity and real input.  

 activate, logic state of corresponding function is 1.  

 deactivate, logic state of corresponding function is 0.  

OUT function Description  

Ready  Controller is ready to be enabled 

Error Controller error 

Pos Reached 
Under position mode, position difference between Pos_Actual and 

Pos_Target<Target_Pos_Window(6067.00),duration>=Position_Window_time(6068.00) 
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Zero Speed 
|Speed_1ms(60F9.1A)|<=Zero_Speed_Window(2010.18) and 

duration >=Zero_Speed_Time(60F9.14) 

Motor brake 
Signal for controlling the motor brake. By this signal an external relay can be controlled, by 

which the motor brake is controlled. (see chapter 3.2.4).  

Speed Reached |Speed_Error(60F9.1C)|<Target_Speed_Window(60F9.0A) 

Enc Index 
Encoder position is inside a range around the index position. This range is defined by 

Index_Window(2030.00). 

Speed Limit In torque mode actual speed reached Max_Speed(607F.00) 

Driver Enabled Controller enabled 

Position Limit Position limit function is active 

Home Found Home found 

4.5 Scope 

The scope function is for sampling the selected objects ɏ value with a flexible sample cycle 

(defined by Sample Time ) and a flexible total sample number (defined by Samples ) 

During operation, if performance does not meet the requirement or any other unexpected 

behaviour occurs, it ɏs highly advisable to use the scope function to do the analysis.  

Click Driver -- > Oscilloscope  or click   to open the scope window  
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Trig offset : Number of samples before the trigger event occurs.  

Object : Maximum 64 -bit length data can be taken in one sample, e.g.: 2 Int32 objects bit 

or 4 Int16 objects.  

Single :  means sample for one trigger event only.  means sample 

continuously.  

Zoom in / zoom out the oscillogram : Press the right mouse key and d rag to lower right 

/ upper left. Left mouse click on  activates the horizontally drag mode, the icon changes 

to  and inside the oscillogram display area the mouse cursor changes to finger shape. A 

zoomed oscillogram can be moved then in horizontal direct ion by pressing the left mouse 

button and dragging to left/right.  

Left mouse click on  or any zoom -in or zoom -out action cancels the drag mode 

automatically.  

Cursors : Up to 4 scope cursors can be selected by clicking the respective button: . 

The scope cursors appear in the oscillogram. Select a channel in the Sel CH  list box. Move the 

mouse pointer to the scope cursor. Press left mouse button and drag the scope cursor to move 

it. A sample value and the differences of X1, X2 and Y1, Y2 appear  in the following fields : 
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4.6 Error display and error history 

Error : Click Controller -> Error Display  or click the  button (which turns red  if an 

error occurs). The  Error Display window appears. It shows the last errors.  

Error History : Click menu item Controller -> Error History . The error history list window 

appears. It shows the last 8 errors ɏ Error codes and respective the related DCBUS voltage, 

speed, current, controller temperature, Operation_Mode, and controller working time at the  

moment when the error occurred.  

Error_state information:  

Bit Error name Error code Description 

0 Extended Error  Refer to object ɒError_State 2ɓ(2602.00) 

1 Encoder not connected 0x7331 No communication encoder connected 

2 Encoder internal 0x7320 Internal encoder error 

3 Encoder CRC 0x7330 Communication with encoder disturbed 

4 Controller Temperature 0x4210 Heatsink temperature too high 

5 Overvoltage 0x3210 DC bus overvoltage 

6 Undervoltage 0x3220 DC bus undervoltage 

7 Overcurrent 0x2320 Power stage or motor short circuit 

8 Chop Resistor 0x7110 Overload, brake chopper resistor 

9 Following Error 0x8611 Max. following error exceeded 

10 Low Logic Voltage 0x5112 Logic supply voltage too low 

11 Motor or controller IIt 0x2350 Motor or power stage IIt error 

12 Overfrequency 0x8A80 Pulse input frequency too high 

13 Motor Temperature 0x4310 Motor temperature sensor alarm 

14 Encoder information 0x7331 No encoder connected or no encoder communication reply 

15 EEPROM data 0x6310 EEPROM checksum fault 

Error_state2 information:  

Bit Error name Error code Description 

0 Current sensor 0x5210 Current sensor signal offset or ripple too large 

1 Watchdog 0x6010 Software watchdog exception 

2 Wrong interrupt 0x6011 Invalid interrupt exception 

3 MCU ID 0x7400 Wrong MCU type detected 

4 Motor configuration 0x6320 No motor data in EEPROM / motor never configured 
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5 Reserved   

6 Reserved   

7 Reserved   

8 External enable 0x5443 
DIN "pre_enable" function  is configured, but the DIN is inactive 

when the controller is enabled / going to be enabled  

9 Positive limit 0x5442 
Positive position limit (after homing) Ɋ position limit only causes 

error when Limit_Function (2010.19) is set to 0. 

10 Negative limit 0x5441 
Negative position limit (after homing) position limit only causes 

error when Limit_Function(2010.19) is set to 0. 

11 SPI internal 0x6012 Internal firmware error in SPI handling 

12 Reserved   

13 
Closed loop 

direction 
0x8A81 

Different direction between motor and position encoder in closed 

loop operation by a second encoder. 

14 Reserved   

15 Master counting 0x7306 Master encoder counting error  
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Chapter 5 Operation mode 

5.1 Velocity mode (-3, 3) 

There are 2 kinds of velocity mode : -3 and 3. The velocity command can be specified via 

Target_Speed or analog input (analog speed mode), or via digital input (DIN speed mode).  

Table0Ɋ1 Velocity mode 

Internal 

address 
Type Name  Description  value 

60600020 Integer8 
Operation 

mode 

-3: The velocity command is specified directly 

by Target_Speed. Only the velocity control loop 

is active. 

3: The velocity command is specified by 

Target_Speed with profile acceleration and 

profile deceleration. Velocity- and position 

control loops are active 

-3 and 3 

60400010 Unsigned16 
Control 

word 

0x0F: Enable the controller ψ0x06: Disable the 

controller 
0x0F 

60FF0020 Integer32 Target-speed Target velocity, cannot over motor rated speed User defined 

60810020 Unsigned32 Profile_Acc Active in mode 1 and 3 
Default as 

100rps/s 

60830020 Unsigned.32 Profile_Dcc Active in mode 1 and 3 
Default as 

100rps/s 

 

In software " Basic operation " window, we can find these parameters and set, on the 6th, 

7th, 10th, 11th, 12th, respectively.  
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Figure 5-1 ñBasic operationò window 

 

5.1.1 Analog speed mode 

The analog speed object window in the PC software can be accessed via menu item 

Controller ->Control Modes ->Analog Speed Mode . 

Table0Ɋ2 Analog speed mode 

Internal 

address 
Type Name Description Value 

250.0610 Unsigned16 ADC1_Buff[1] AIN1 input real data 

Only read 

25020F10 Integer16 Analog1_out 
AIN1 valid input; analog input signal1 (AIN1) 

input voltage after filter, deadband and offset 

25010710 Unsigned16 ADC2_Buff[1] AIN2 input real data 

25021010 Integer16 Analog2_out 
AIN2 valid input; analog input signal2 (AIN2), 

input voltage after filter, deadband and offset 

25020110 Unsigned16 Analog1_Filter AIN1 filter (unit: ms) 

User 

defined 
2FF01D10 Integer16 Analog1_Dead_V AIN1 deadband (unit: 0.01V) 

2FF01E10 Integer16 Analog1_Offset_V AIN1 offset (unit: 0.01V) 
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25020410 Unsigned16 Analog2_Filter AIN2 filter (unit: ms) 

2FF01F10 Integer16 Analog2_Dead_V AIN2 deadband (unit: 0.01V) 

2FF02010 Integer16 Analog2_Offset_V AIN2 offset (unit: 0.01V) 

25020A10 Integer16 Analog_Speed_Factor AIN speed factor 

25020708 Unsigned8 Analog_Speed_Con 

0: analog velocity control OFF, velocity 

control via Target_Speed(60FF.00) 

1: Speed control via AIN1 

2: Speed control via AIN2 

1 or 2 

25020D10 Integer16 Analog_Dead_High 
Default is 0, if it's NOT 0, Analog_out> 

Analog_Dead_High is treated as 0 

User 

defined 

25020E10 Integer16 Analog_Dead_Low 
Default is 0, if it's NOT 0, Analog_out< 

Analog_Dead_Low is treated as 0 

60600008 Integer8 Operation mode 4: Torque mode 

60400010 Unsigned16 Controlword Driver enable 

 

  

Figure 5-2 ɒAnalog Velocity Modeɓwindow 

For convenience, some new names are used in the formula. Definitions:  
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AIN1_in: AIN1 input voltage after filter and offset  

AIN2_in: AIN2 input voltage after filter and offset  

Analog_out: Analog1_out or Analog2_out, depends on  wiring and Analog_Speed_Con setting; 

Itɏs the result of AIN real input, filter, offset and deadban d. 

 

Final result:  

Analog_Speed control ON:  

If Analog_out is not limited by Analog_Dead_High or Analog_Dead_Low:  

Target speed[rpm]=Analog_out[V]*Analog_Speed_Factor[rpm/V]; otherwise Target 

speed[rpm]=0.  

Analog_MaxTorque control ON:  

Max torque[Nm]=Analog_out[V]*Analog_MaxT_Factor[Nm/V]  

 

Example: 

Setting:  Analog1_Dead=1V, Analog1_Offset=2V, Analog_Speed_Factor=100rpm/V, 

Analog_Speed_Con=1, Analog_Dead_High=0V; Analog_Dead_Low=0V;  

Where AIN1 input voltage is 5V:  

AIN1_in=5V Ɋ2V=3V, |AIN1_in| >Analog1_Dead, so Analog1_out=3V Ɋ1V=2V;  

Target speed=2*100=200rpm.  

Where AIN1 input voltage is -5V: 

AIN1_in= -5VɊ2V= -7V, |AIN1_in|>Analog1_Dead, so Analog1_out= -7V+1V= -6V;  

Target speed= -6*100= -600rpm.  

5.1.2 DIN Speed mode 

The Din_Speed object window in PC software can be accessed from menu item 

Controller -> Control Modes -> DIN Speed Mode . 

To make the DIN Speed Mode available, at least one of the following has to be configured to 

DIN: Din Vel Index0 , Din Vel Index1 , Din Vel Index2 . 

Table0Ɋ3 DIN speed mode  

Internal 

address 
Type Name Description Value 

20200520 Integer32 Din speed[0] 
The velocity command is specified via Din_Speed[x]. 

x is the BCD code of 

Bit 0: Din Vel Index0 

User 

defined 
20200620 Integer32 Din speed[1] 

20200720 Integer32 Din speed[2] 
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20200820 Integer32 Din speed[3] Bit 1: Din Vel Index1 

Bit 2: Din Vel Index2 

A bit which is not configured means 0. 
20201420 Integer32 Din speed[4] 

20201520 Integer32 Din speed[5] 

20201620 Integer32 Din speed[6] 

20201720 Integer32 Din speed[7] 

Exampleχ 

I/O configurationχ 

 

Figure 0Ɋ3 IO configuration 

  

Figure 0Ɋ4 IOɒDIN speed modeɓwindow  
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Table0Ɋ4 DIN Speed mode  

Internal address Type  Name Value Unit  

20200E08 Integer8 Din mode 1 -3  

20200732 Integer32 Din speed [2] 500 rpm 

Din Vel Index0 =0; Din Vel Index1 =1; Din Vel Index2 =0. As soon as DIN1 is active, the 

controller runs the motor in the velocity mode(Operation_Mode= -3) at 500rpm speed if there aren ɏ

t any unexpected errors or limits.  

5.2 Torque mode (4) 

In the torque mode, the CD3 motor controller causes the motor to rotate with a specified torque 

value. 

Table 0Ɋ5 Torque mode 

Internal 

address 
Type Name  Description Value  

60600008 Integer8 
Operation_mo

de 
 4 

60710010 Integer16 
Target_Torque

% 

Target torque, 

percentage of rated torque 

User 

define 

60400010 Unsigned16 Controlword Enable driver 0x0F 

5.2.1 Analog torque mode 

In the analog torque mode, the CD3 motor controller controls motor torque and / or maximum 

torque by means of analog input voltage.   

The analog torque object window in the PC software can be accessed via menu item 

Controller -> Control Modes -> Analog Torque Mode . 
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Figure  0Ɋ5 ɒAnalog torque modeɓwindow 

 

 

Table0Ɋ6 Analog torque mode 

Internal 

address 
Type Name  Description  Value  

25010610 Unsigned16 ADC1_Buff[1] AIN1 real input voltage 

Read 

25020F10 Integer16 Analog1_out 

AIN1 valid input, analog input signal1 

(AIN1), input voltage after filter, deadband 

and offset 

25010710 Unsigned16 ADC2_Buff[1] AIN2 input real data  

25021010 Integer16 Analog2_out 

AIN2 valid input, analog input signal2 

(AIN2), input voltage after filter, deadband 

and offset 

25020110 Unsigned16 Analog1_Filter AIN1 filter (unit: ms)  

User 

defined 
25020210 Integer16 Analog1_Dead_V AIN1 deadband (unit: 0.01V) 

25020310 Integer16 Analog1_Offset_V AIN1 offset (unit: 0.01V) 
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25020410 Unsigned16 Analog2_Filter AIN2 filter (unit: ms)  

25020510 Integer16 Analog2_Dead_V AIN2 deadband (unit: 0.01V) 

25020610 Integer16 Analog2_Offset_V AIN2 offset(unit: 0.01V) 

25020B10 Unsigned16 
Voltage_Torque_Facto

r 
AIN-Torque factor (unit: mNM/V) 

25020808 Unsigned 8 Analog_Torque_Con 

0: Analog_Torque_control OFF, target torque 

is specified by Target_Torque% (6071.00) 

1: Torque control via AIN1 

2: Torque control via AIN2 

1 or 2 

25020C10 Unsigned16 Voltage_MaxT_Factor AIN-MaxTorque factor (unit: mNM/V) 
User 

define 

0, 1, 2 25020908 Unsigned 8 Analog_MaxT_Con 

0: Analog_MaxTorque control OFF  

1: max. torque control via AIN1; 

2: max. torque control via AIN2 

60F60310 Unsigned16 Speed_Limit_Factor 

Influence max speed limit 0x60800010, if 

value is bigger, limit is better, but if it is too 

big, it will cause noise 

10 

60800010 Unsigned16 Max_Speed rpm Limit motor max speed  

 

 

Note  

Analog_MaxT_Con is not only used in operation mode 4. All operation modes can 

use analog output to limit max torque output.  

For convenience, some new names are used in the formula. The definitions are as follows:  

AIN1_in: AIN1 input voltage after filter and offset.  

AIN2_in: AIN2 input voltage after filter and offset.  

Analog_out: Analog1_out or Analog2_out, depends on wiring and Analog_Torque_Con setting . 

Itɏs the result of AIN real input, filter, offset and deadband.  

 

Final Result:  

When Analog_Torque control is ON, target 

torque[Nm]=Analog_out[V]*Analog_Torque_Factor[Nm/V].  

When Analog_MaxTorque control is ON, max. 

torque[Nm]=Analog_out[V]*Analog_MaxT_Fa ctor[Nm/V].  
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5.3 Position mode (1) 

In the position mode, the CD3 motor controller causes the motor to rotate to an absolute or 

relative position. The position / velocity command is specified via Target_Position / Profile_Speed 

or via position table (Positio n Table Mode)  

Table 0Ɋ7 Position mode 

Internal 

address 
Type Name  Description  Value  

60600008 Integer8 
Operation_

Mode 
Way of control motor 1 

607A0020 Integer32 
Target_Pos

ition 
Target absolute / relative position  User defined 

60810020 Unsigned32 
Profile_Sp

eed 
Profile speed for positioning User defined 

60400010 Unsigned16 
Controlwor

d 

Switch from 0x2F to 0x3FχAbsolute position;  

Switch from 0x4F to 0x5FχRelative position 

0x2F->0x3F or 

0x4F->0x5F 

5.4 Pulse mode (-4) 

In the pulse mode, the target velocity command is specified via the pulse input with gear ratio.  

 

Table0Ɋ8 Pulse mode 

Internal 

address 
Type Name  Description  Value  

6060000

8 
Integer8 Operation_Mode Operation mode -4 

2508011

0 
Integer16 Gear_Factor[0] 

Gear_ratio=Gear_Factor/Gear_Divider 
User 

define 2508021

0 

Unsigned1

6 
Gear_Divider[0] 

6040001

0 

Unsigned1

6 
Controlword Enable driver 0x2F: 

2508030

8 
Unsigned 8 PD_CW 

Pulse train mode 

0: CW / CCW 
0, 1, 2 
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1: Pulse / direction 

2: A / B (incremental encoder)  

2508061

0 

Unsigned1

6 
PD_Filter Pulse filter (ms) 

User 

define 2508081

0 

Unsigned1

6 

Frequency_Chec

k 

Frequency limit (inc/ms), if pulse count (in 1 ms) 

is greater than Frequency_Check, over 

frequency error occurs. 

Table0Ɋ9 PD_CW schematic 

Pulse mode  Forward  Reverse 

P/D 

  

CW/CCW 

  

A/B  

  

 

 

Note  

Iruzdug phdqv srvlwlyh srvlwlrq frxqwlqjɏv ghidxowhg wr wkh CCW direction. You 

can set Invert_Dir(607E.00) to 1 in order to invert the direction of motor shaft 

rotation.  

 

 

Figure 5-6  Pulse filter principle 
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5.5 Homing mode  (6) 

For some applications, the system needs to start from the same position every time after power 

on. In the homing mode, the user can specify the system ɏs home position and a zero (starting) 

position.  

Click menu item Controller -> Control Modes , and the following window appears:  

  

Figure 0Ɋ7 Homing mode 

Select a home trigger under Homing Trigger . The related items appear in the configuration  

area. Select a suitable item according to mechanical design and wiring. The Appropriate 

homing_method then appears in the Pre-Set Home Method  box . If Disabled  is selected under 

homing trigger, you enter a number directly to the Pre-Set Home Method  field. Click  

to set it to the controller.  

The corresponding diagram of the Pre -Set Home method appears in the middle area.  

 

All homing mode objects are listed in following table:  

 

Table0Ɋ10 Homing mode 

Internal 

address 
Name Type Value Description 

607C00

20 
Home_Offset Integer32 

User 

define 
Zero position offset to the home position 
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Note  

Homing_Power_On=1 causes the motor to start rotating as soon as the controller 

is enabled after power on or reboot. Consider all safety issues before using.  

Home_N_Blind: 

If the homing_method needs home signal (position limit / home switch) and index signal, 

Home_N_Blind function can avoid the homing result being different with the same mechanics, when 

the Index signal is very close to the home signal. By setting to 1 before homing, the controller 

detects a suitable blind window for homing automatically. It can be used to assure that h oming 

results are always the same.  

During homing, the index signal inside this blind window is ignored after the home signal is 

6098000

8 

Homing_Metho

d 
Integer 8 

User 

define 
Way of homing method 

6099022

0 

Homing_Speed

_Zero 

Unsigned2

0 

User 

define 

Velocity for finding home position and zero 

position 

6099030

8 

Homing_Power

_On 
Unsigned 8 0ι1 

1: Start homing after power on or reboot and 

first controller enable 

609A00

20 

Homing_Accel

aration 

Unsigned3

2 

User 

define 

Profile deceleration and acceleration during 

homing 

6099012

0 

Homing_Speed

_Switch 

Unsigned3

2 

User 

define 

Velocity for searching position limit switch / 

home switch signal 

6099041

0 

Homing_Curre

nt 
Integer8 

User 

define 
Max. current during homing 

6099050

8 

Home_Offset_

Mode 
Unsigned 8 0ι1 

0: Go to the homing offset point. The actual 

position will be 0. 

1: Go to the home trigger point. The actual 

position will be -homing offset. 

6099060

8 
Home_N_Blind Unsigned 8 0ι1 

Home blind window 

0: 0rev 

1: 0.25rev 

2: 0.5rev 

6060000

8 

Operation_Mod

e 
Integer8 6 Operation mode 

6040001

0 
Controlword 

Unsigned1

6 

0x0F->0x

1F 
Enable driver 
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or 2 after homing dependi ng on the index signal position relative to the homing signal.This 

parameter needs to be saved. If the mechanical assembly is changed or the motor has been 

replaced, just set it to 1 again for initial homing.  

Table0Ɋ11 Introduction to homing mode 

Homing

_metho

d 

Description  Schematic  

1 

Homing with negative 

position limit switch and 

index pulse  

 

2 

Homing with positive 

position limit switch and 

index pulse  

 

3 
Homing with home 

switch and index pulse  

 

4 
Homing with home 

switch and index pulse  

 


























































































































































